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I. Infoporte Navigation Overview 

 

Navigation  First Level Tab Second Level Tabs 

Home   

Inbox Requests  

Calendars  

Finance Dept Accounting � Ledger Rollup 

� OSR Ledger Rollup 

� Transactions 

� GL Transactions 

� Grant Profile 

� Soft Encumbrances  

� Cost Codes 

Financial 

Reporting (SAS 

menu) 

� A series of reports under 4 

headings: 

o Ledg/Acct 

o Cash/Bal 

o Cost Codes 

o Misc 

Financial Request  

Budget Process  (limited access) 

Other Reports Currently only has the BMS report for 

depts. with State money 

Legacy 

Accounts 

Overview � SL Overview 

� GL Overview 

List Accounts 

 

� Subsidiary Ledger 

� General Ledger 

� Personnel Allocations 

� PID/Accounts 

� Employee Projections 

Payroll List � Payroll List 

Cost Codes � Cost Code Reports 

� List Cost Codes 

� PID/Cost Codes 

HR Employees  

Positions  

Reports � Report Type: Funding (1 report) 

� Report Type: Person (16 report) 

Request  

Payroll � Earnings Distribution 

� Check Register 

� Summarized Payroll 

Legacy HR Employees  

Payroll List  

Request  

Forms  

PID/Employees  

Faculty Faculty Profile � Profile 

� Curvita-CV Plus 

� ReachNC-Collaboration 

� Request 

� Activity Report 

Legacy 

Faculty 

Faculty Profile � Profile 

� Curvita-CV Plus 

� ReachNC-Collaboration 

� Activity Report 

Tools Reservations � Rooms 

� IT Equipment 

Data Dictionary � FRS Account Mapping (Account 

Mapping; Advanced Mapping)  

� Data Dictionary List 

� Chartfield Lookup 

� Cost Codes 

� General Info 

� What’s New? 

Cores Purchase � Purchase Items 

� Recent Purchases 

Settings   
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 II. Overview of Commitment Control  

Commitment Control (“KK”) is the PeopleSoft module that handles 

budgeting. KK organizes transactions into Ledger Groups separated by 

Revenues and Expenses – these are best visualized in matrix: 

 State F&A Trust OSR 

Revenues X  X  

Expenses X X X X 

 

The “X” indicates the Ledger Groups that campus users will encounter  

(i.e. State Expenses, F&A Expenses, State Revenues, etc.). 

Chartfield fund ranges fall into these Ledger Groups as follows: 

Ledger Group Related Funds Descriptions 

State 201xx 

211xx 

212xx 

Academic affairs funding… 

Health affairs funding… 

AHEC funding… 

… for state appropriations, school-based 

tuition (SBT), or state receipts  

F&A 271xx F&A (“overhead”) pool (does not include 

grant residuals) 

Trust 241xx 

281xx/282xx 

291xx/292xx 

295xx 

299xx 

Education & general self-supporting 

University endowments 

University trusts 

Auxiliary (recharge centers) 

Agency and Foundation 

OSR 252xx Contracts & Grants 

 

Each Revenue Ledger Group is broken down into 3 revenue budget ledgers 

- Budget – records the budget 

- Recognized – when invoiced (and generally received in SPH case) 

- Collected – when revenue is received (mainly pertains to limited 

departments that use the A/R Billing module) 

Each Expense Ledger Group is broken down into 4 expense budget ledgers 

- Budget – records the budget – includes the permanent and revised 

budgets from Budget Office and budget transfers and journals 

initiated by campus users 

- Pre-encumbrances – ePro orders, purchase requisitions 

- Encumbrances – purchase orders, personnel 

- Expenses – purchase orders and ePro when paid; personnel costs 

when paid; vouchers when budget checked 

Other terms to understand: 

- Fiscal Year – the fiscal year begins July 1 and ends June 30. Fiscal 

2015 represents July 1, 2014 through June 30, 2015. 

- Budget Period – corresponds to the fiscal year for all fund types 

other than OSR. This field will generally default. OSR does not use 

the budget period, so leave blank for OSR-related queries or no data 

will result. 

- Accounting Period – the accounting month to which a transaction 

pertains prior to the accounting close. July = 1, August = 2, etc. 

- Associate Revenue – applicable to trust funds only. Represents 

actual cash revenues received (e.g. gift receipts, residual fund 

balances, etc.) For most trust funds, spending is guided by associate 

revenue rather than budget. As such, budgeting for trust revenues 

will only apply in limited cases for recharge centers or conference 

fees where spending might occur prior to revenue generation.  

KK organizes transactions into Ledger Groups and Infoporte reporting 

mirrors this structure – it is critical to understand the Commitment Control 

structure before running reports. 

This was a brief overview; each fund type has specific budget definitions. 

See Appendix 1 for the budget definitions applicable to SPH.  
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III. Balance Reporting Options  

 
Option 1- ConnectCarolina Budget Overview Option 2- Infoporte Ledger Rollup Option 3- Infoporte Financial Reporting (SAS) 

O
v

e
rv

ie
w

 

• Provides expenses, (pre-) encumbrances, 

and balances by detailed chartfield string 

down to the account 

• An aggregated balance is also shown 

• Report is based on real-time 

ConnectCarolina data 

 

• Summarizes budgets, (pre-) encumbrances, 

and balances, by categorized accounts 

• Sorted by source; fund purposes are 

aggregated 

• Similar to Account Objects tab of Finanseer  

• As of 2/2/2015 there is no grand total across 

sources 

• Drills down to detailed transactions 

• All Infoporte data is one day in arrears 

 

• Provides a suite of 12 reports; most useful: 

“Financial Breakdown” reports and the 

Funding Balance Report 

• Summarizes budgets, (pre-) encumbrances, 

and expenses at an aggregated level 

summarized by fund and source 

• Similar to Overview tab of Finanseer 

• Two levels of drilldowns are available 

• All Infoporte data is one day in arrears 

B
e

st
 F

o
r 

• Looking for a budget at a specific 

chartfield, such as to verify whether 

sufficient budget exists for an planned 

transaction  

• Downloading details to Excel for pivot 

table analysis 

• “Chartfield focus” 

• Getting a quick overview of overall spending in 

a Source  

• Downloading to PDF for record-keeping 

• “Source focus” 

• Reporting on trust balances (Use the Funding 

Balance Report) 

• Reviewing aggregated financial information 

across accounts (e.g. total non-personnel at a 

glance)  

• “Fund-source-dept focus” 

N
a

v
ig

a
ti

o
n

 a
n

d
 D

ir
e

ct
io

n
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Main Menu > Finance Menu > Commitment 

Control > Review Budget Activities > Budgets 

Overview 

1. Name or Choose your named search. 

2. Choose the correct Ledger Group. 

3. Enter your chartfield parameters. 

4. Save your search if you like (optional). 

5. Click “Search” to run the search. 

Evaluate or download results by 

clicking the  icon. 

Infoporte > Dept Accounting > (OSR) Ledger Rollup 

(The Ledger Rollup tab houses F&A, STATE, and 

TRUST transactions; OSR balances are found in the 

OSR Ledger Rollup tab.) 

1. Choose the appropriate Ledger. 

2. The Fiscal Year and Budget Year should 

default to the current year.  

3. Select or enter other search parameters, 

such as departments, funds, sources, or 

accounts, etc. 

4. The balance will only calculate if you leave 

Acct Period as “show all”.  

5. Click “Search” to run the search. 

6. Click the Excel or PDF icons to download 

the resulting reports.  

Infoporte > Financial Reporting > [choose the 

appropriate report] 

1. Choose the appropriate report. 

2. Select or enter other search parameters 

such as fiscal year or budget period (make 

sure this is selected), funds, sources, 

depts, or accounts, etc. 

3. The results update automatically. 

4. Click on the data area and choose 

 to download to Excel. 

Click “OK” when the “Save As” windows 

comes up. 
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Option 1- ConnectCarolina Budget Overview Option 2- Infoporte Ledger Rollup Option 3- Infoporte Financial Reporting (SAS) 

T
ip

s 

 

1. For detailed instructions on running the 

overview, please refer to the SPH Finance 

ConnectCarolina page for Budget 

Inquiries: 

http://sph.unc.edu/sph-

finance/connectcarolinaupdates/budget-

inquiries/  

 

2. Refer to the Budget Definition (see 

Appendix 1). If you run a budget inquiry 

and no data results, one or more of your 

search parameters are likely not in the 

budget definition.  E.g., 

o For F&A, you might have entered 

the Fund as 27101 instead of the 

appropriate pool level of 27100. 

(It’s recommended you leave the 

Fund blank for searching.) 

o For State, you might have entered 

an account at the transaction level 

(e.g. EPA faculty 513120) instead 

of at the appropriate budget pool 

level (e.g. EPA Teach salaries 

513100) 

o For Trust, you might have entered 

the Fund at the transaction level 

instead of at the budget pool level 

(e.g. 24100 or 29500)  

 

3. ConnectCarolina uses “%” as a wildcard 

search parameter. 

 

4. The default max rows returned is 100. If 

your search exceeds this, you can update 

the max rows field to 300/500/1000 and 

then click Search again. 

 

1. The Actuals MTD column only shows the 

transactions for the last month as filtered by 

the Acct Period.  

 

2. You can obtain the month-end balance by 

selecting a single historical month in the Acct 

Period (e.g. 6-December). The Actuals MTD 

column will show the total amounts incurred 

during December whereas the Actuals YTD 

column will show cumulative actuals for the 

fiscal year. The FMS balance will show the 

balance as of December 31, 2014 in this case. 

 

3. For each search that is run, the corresponding 

transaction list will appear at the bottom for 

convenience. Reviewing these transactions is 

rather cumbersome, however. It is 

recommended you correspond with the ledger 

rollup results using the Transactions tab 

instead. 

 

4. If soft encumbrances or projections are used, 

only this reporting option will show the 

Infoporte balance (“IPT Balance”). 

 

1. For State, Trust, and F&A be sure to select the 

proper Budget Period (i.e. 2015) or data will 

not be correct. This field does not 

appropriately default. 

 

2. The report will automatically show the 

departments for which you have access. 

 

3. The Department filter box allows for many 

levels of departments; the rightmost “Detail 

Dept” box contains the familiar department 

codes if you need to filter down. 

 

4. Similar to the notes in Option 2, it is possible 

to see actuals for one historic month by 

selecting a specific Accounting Period, but the 

FMS Balance will be incorrect.  

 

5. Similar to the notes in Option 2, the only way 

to see historic month end balance is to select 

cumulative months. Similarly, this search will 

include Actuals for all cumulative months. 
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IV. Recommended Balance Reporting Options for Different Funding Types  

A. State Expenses 

For state expenses, all 3 options work depending on the questions you’d like answered: 

Example Business Question Recommended Reporting Option 

Do I have enough budget in EPA NF in health 

affairs appropriations? (chartfield focus) 

Option 1 (ConnectCarolina Budget Overview) shows budget at the 

specific chartfield level down to the account. This report will also 

tell you how much budget is available as a “bottom line”. 

What sort of expenses have we been spending 

from health affairs appropriations? (source 

focus) 

Option 2 (Infoporte Ledger Rollup) provides a summary of spending 

within a source by major categories, while also summarizing the 

bottom line balance. 

How much state money is left in my department 

(bottom line)? (fund-source-dept focus) 

Option 3 (Infoporte SAS report – State Financial Breakdown) 

provides aggregated information by the fund and source. 

 

Option 1: ConnectCarolina Budget Overview 

Run the inquiry with the following parameters: 

Field Inputs Notes 

Ledger Group STATE (description: State Expense Child 

Budget) 

 

Account This may be left as % to show the entire state 

balance.  

 

If you are doing a search for a specific 

chartfield (say for the purpose of checking 

whether budget exists for a specific 

transaction) You may also choose to specify 

an account from the State Budget Definition 

Account Listing (see Appendix 1). 

Similar to FRS, ConnectCarolina budgets on 

certain budget pools (or “budget rollups”). For 

example, all supplies and current services roll up 

to account 520000. Your search will not result in 

data unless you choose an appropriate budget 

pool account. 

Dept Enter your department. If you forget to enter dept, the whole university 

data will result. 

Fund and Source 

 

Enter an appropriate combination of Fund and Source as appropriate. For example: 

• Source 13001 (HA approp), or 

• Source 13517 (state receipts), or 

• Source 12001 (AA approp – distance) 

• Returns all transactions and budgets for 

the source regardless of fund purpose. 

• Fund range 20101 to 20199 (AA) 

• Fund range 21101 to 21199 (HA) 

• Fund range 22101 to 22199 (AHEC) 

• Returns all transactions and budgets for 

all funds and sources within type of state 

funding including SBT and health affairs 

state receipts. 

• Fund 21101 and Source 13001 

• Fund 21152 and Source 13001 

• Fund 21101 and Source 12001 

• These combinations return the 

transactions and budgets for the specific 

chartstring. 

• Leave both fund and source criteria 

as %.  

• This will return ALL state money for the 

specified department. 

A summary “Available Budget” will be presented at the top with a matrix showing Available Balances for each chartfield 

combination for the given parameters. The matrix may be downloaded by clicking the  icon above the matrix. This 

download is useful for analysis down to the specific chartfield including fund purpose. 
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Option 2: Dept Accounting – Ledger Rollup 

Run the report using the following parameters: 

Field Inputs Notes 

Ledger  Check off STATE.  

Dept ID Enter or check off the 

appropriate department(s). 

 

Source Optional.  If you do not enter a Source, all possible Sources will appear in a 

separate grid. 

Fiscal Year and 

Budget Period 

These should default to the 

current fiscal year. 

Leave as is. 

Acct Period Defaults to “(show all)”.  Leave as is, unless you’d like to see results for a specific month. 

The results will list each source in a separate grid. Note that these results combine the funds, that is, it is not possible to 

distinguish how much was spent using xxx01 purpose versus xxx52 purpose from this presentation. Also, no “grand total” 

is presented; the only totals are at the Source level (source focus) (grand totals should be implemented with a future 

enhancement). 

 

Option 3: Financial Reporting – SAS 

Choose the State Financial Breakdown (Legacy FBM 09X) report and enter the following parameters. 

Field Inputs Notes 

Business Unit, 

Fiscal Year 

These should default to the correct 

values (UNCCH, 2015) 

 

Accounting 

Period 

Leaving blank assumes all are 

selected. 

 

Department Choose the appropriate department.  Click on the “Detail Dept” box to see the standard listing of 

department numbers. 

Budget Period Check off the appropriate period 

corresponding to the fiscal year. 

This does not default. If you do not check this off, your data 

will be skewed. 

Fund and 

Source 

Choose an appropriate combination 

similar to the thought process 

outlined in Option 1. 

If this is left blank, all available data will show. For example, 

if your department has both academic affairs and health 

affairs funding, both will result. 
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The following is an example search for the equivalent department as presented in Option 2. As you can see, the FMB 

balances match up by the source, but no account-level information is shown. If spending has been recorded to other 

purposes, those breakdowns would be shown. 

 

B. State Revenues 

Option 2: Dept Accounting – Ledger Rollup is preferred since it combines the presentation with the relevant state 

expenses. That is, if you run the search as in A. State Expenses Option 2, you will also obtain data related to the 

corresponding state revenues. However, determining the actual balance requires a manual calculation: 

Revenues generated:  $98,798.74 

Less Actual expenses:  ($37,699.63) 

Less Encumbrances: ($7,062.91) 

Less Pre-encumbrances: ($30.08) 

Actual BBA: $52,006.12
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C. F&A 

ConnectCarolina treats F&A as a single departmental pool. Unlike FRS, F&A is not budgeted at the account level; F&A 

line-item budgets do not exist. When looking up F&A balance, it is a single budget pool for the department.  

Option 1: ConnectCarolina Budget Overview most readily provides the bottom line figure. 

Field Inputs Notes 

Ledger Group F&A (description: F&A Expense Budget)  

Dept Enter your department. If you forget to enter dept, the whole university 

data will result. 

Source Optional. All F&A resources will result if this is left blank. 

(There are only 3 F&A sources.) 

Fund Optional. Recommend you leave this blank. 

 

The results readily summarize the available budget while the breakdown shows the distribution of the balance/deficit 

among the sources.  

 

Option 2: Dept Accounting – Ledger Rollup provides a summary of expenses but requires manual calculation to 

determine the balance. 

Field Inputs Notes 

Ledger  Check off F&A.  

Dept ID Enter or check off the 

appropriate department(s). 

 

Source Optional.  If you do not enter a Source, all Sources will appear in a separate grid. 

Fiscal Year and 

Budget Period 

These should default to the 

current fiscal year. 

Leave as is. 

Acct Period Leave default as “(show all)”. Leave as is, unless you’d like to see a balance as at a certain month 

end, in which case you can select specific months. 

The results break down the expenses by major expense category. You will notice that each expense line appears to be in 

a deficit – this is because budgets are not established at the account level. Instead, the F&A budget pool is captured in 

the line currently marked as “Budget” . The actual F&A balance for source 14101 is circled in red below in the “total” line. 

The Suspense sources 14102 and 14103 are also charged to the F&A pool. Since these sources do not normally have a 

budget, this presentation requires manual calculation to determine the actual balance. In the next example, the total for 

Source 14101 is $115,465.22 less the deficit in Source 14102 of $653.38 results in an actual balance of: $114,811.84. 
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Option 3: Financial Reporting – SAS Report summarizes what is presented in Option 2, but still requires manual 

calculation to determine the final balance. 

Choose the F&A Financial Breakdown (Legacy FBM 09X) report. 

Field Inputs Notes 

Business Unit, 

Fiscal Year 

These should default to the correct values 

(UNCCH, 2015) 

 

Accounting 

Period 

Leaving blank assumes all are selected.  

Department Choose the appropriate department.  Click on the “Detail Dept” box to see the standard 

listing of department numbers. 

Budget Period Check off the appropriate period 

corresponding to the fiscal year. 

This does not default. If you do not check this off, 

your data will be skewed. 

Fund and 

Source 

Optional. If this is left blank, all available data will show. For 

example, if your department has both academic affairs 

and health affairs funding, both will result. 
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D. OSR Contracts & Grants 

Projects in the OSR Ledger are different from the others in that the Budget Period field is not used. If a Budget Period  

(i.e. 2015) is specified, NO data will result. All three reporting options will readily inform you of the overall project 

balances but be careful about inputting the correct search criteria to ensure cost share is not commingled. 

Option 2: Dept Accounting – OSR Ledger Rollup (be sure to choose the OSR Ledger Rollup tab) This is probably the 

easiest search that provides overall spending information and provides month-end balances for the purpose of 

preparing NOTRs. 

Field Inputs Notes 

Dept ID Optional.  

Project Input your Project ID.  

Fund/Source/Account Optional. It is not necessary to input anything for these fields. 

Fiscal Year  Leave default as “(show all)”. Leave as is, unless you’d like to drill down into expenses for 

the current fiscal year; the budget will disappear. 

Acct Period To show a month-end balance, 

choose a single month of this 

fiscal year.  

For example, if you choose 5-November, it will show the 

November-end balance of the grant. 

 

For example, for the project below, the Fiscal Year was selected as “show all” and the Acct Period was selected as “5-

November”. The grant balance in this screenshot below of $107,262.20 represents the grant balance as of November 30, 

2014. The Actuals MTD column shows the actual expenditures for November 2014 only ($359.15) and the Actuals LTD 

column represents the FY15 YTD expenditures from July through November end (the “LTD”, normally standing for life-

to-date is actually a misnomer here.)  

 

 



 

Information in this document is current as of 2/2/2015. Infoporte is being updated on a continual basis and information may be outdated p.11 

Option 1: ConnectCarolina Budget Overview 

Field Inputs Notes 

Ledger Group OSR (description: 

Contracts/Grants Exp Child Bud) 

 

Project ID Enter the Project ID.  

Dept Optional. Since Project IDs are associated with a particular department, 

fund, and source, it is not necessary to include this. 

However, if your project has a cost share component, it is 

recommended you put in the assigned Source or the results will 

include cost share activity. 

Fund Optional. 

Source Optional. 

 

As discussed previously, the Budget Overview screen provides real-time data and does not provide month-end historical 

results. But be careful about the cost share component. The first screenshot below shows a search on Project only; the 

OSR source was not specified. There is a line showing all cost share activity of $40,840.94 expenses which is included in 

total expenses of $402,611.04. In effect, the project expenses and encumbrances are overstated to include cost share 

and therefore the available budget presented of -$18,762.23 is incorrect. The actual balance should be $28,486.32 by 

adding back the cost share expense and encumbrance. The corresponding Source (49000 in this case) should be included 

in the search criteria to exclude the cost share component. The second screenshot shows the ‘fixed’ search result. 
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Option 3: Financial Reporting – SAS Report shows the correct grant balance, but does not include line item information 

unless you drill down so this report is probably least useful.  

Choose the OSR Financial Breakdown (Legacy FBM 09X) report. 

Field Inputs Notes 

Business Unit This should default to the correct value 

(UNCCH) 

 

Fiscal Year Leave this blank. If this is specified as the current fiscal year, the current 

year expenses will show but the budget information will 

disappear similar as in Option 2. 

Accounting 

Period 

Leave this blank.   

Project Input your Project ID.  

Department Leave this blank.  

 

Cost share information does not get commingled in this presentation. This report provides an overall balance but does 

not include any line item information. 

 

 

E. Trust Funds 

Trust funding encompasses a number of different types of fund ranges but generally fall under two categories; the best 

reporting option for these two categories differs: 

(a) Cash-directed Spending: Trust funds that depend on the actual cash balance for spending. This category 

includes university trusts, endowment incomes, certain educational and self-supporting trusts such as grant 

residuals or student fees, and selected auxiliary recharge centers when there is a carry forward balance. 

 

(b) Budget-directed Spending: Trust funds this category generally do not have cash up front to support spending 

and require the setup of trust revenue budgets. Generally, this category includes conference/workshop funds or 

certain recharge centers. Note that even though these sources will have budgeted revenue, actual revenues that 

are generated are recorded as “Associate Revenue”. ConnectCarolina determines the trust balance based on the 

greater of Budgeted Revenues or Associated Revenues. Revenue budgets need to be monitored against 

Associate Revenue as the year progresses to ensure you do not overspend available funds. 
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Cash-directed Spending 

Option 3: Financial Reporting – SAS reports is the only option available for “cash-directed” trust funds as of the time of 

writing. To look for a trust fund balance, open the SAS reports in Financial Reporting. Go into the “Cash/Bal” section and 

choose the Funding Balance Report and input the following parameters: 

Field Inputs Notes 

Fiscal Year The current fiscal year, i.e. 2015 This field does NOT default – be sure to input this 

or your data will be skewed. 

Accounting Period Check off all appropriate periods for which 

you want to include data, including Period 

0 to include beginning balances. 

Only Period 0 defaults. 

Source Specific trust fund Source. Need to type in the number: there is no dropdown, 

and the field also does not search on description. 

Fund Group or 

Fund Code 

Not required. If this is left blank, then all related funds for a source 

will show data. For example, a university 

endowment will show the respective endowment 

principal and income balances. 

Department Levels Not required. Since sources are generally specific to a department, 

entering the specific Source should be sufficient. 

However, in cases where departments share 

sources, then you may consider restricting by the 

department. 

 

Data will automatically update after you input the parameters. There is a “Summary Level” window, which shows 

summary data and the “Fund Detail” window, which shows individual transactions. The Summary Level window is 

probably more useful. 

Both windows can be exported by right clicking in the respective area and choosing “Export Crosstab” to Excel. The 

formatting is not the best. 

Budget-directed Spending 

Option 2: Dept Accounting – Ledger Rollup also has its uses by providing a breakdown of spending by major account 

category. If actual (associate) revenues are less than budgeted revenues, this option allows you to see how much more 

revenues need to be generated. Run the inquiry and choose the following parameters: 

Field Inputs Notes 

Ledger  Check off TRUST.  

Source Enter the specific Source.  Other fields may be left blank unless a Source is shared between 

departments and you’d like to review data for just one department.  

Fiscal Year and 

Budget Period 

These should default to 

the current fiscal year. 

Leave as is. 

Acct Period Defaults to “(show all)”.  Leave as is, unless you’d like to see a balance as at a certain month 

end, in which case you can select specific months.* 
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The following screenshot shows an example trust fund. In order to calculate the actual balance, a manual calculation is 

needed (green circled numbers):  

Revenues generated:  $25,800.00 

Less Actual expenses:  ($11,428.04) 

Less Encumbrances: ($12,724.77) 

Less Pre-encumbrances: ($0.00) 

Actual BBA: $1,647.19 

 

 

 

  

Note 1: This reporting option does not capture opening balances. If 

you have carry forward, use Option 3 as in Cash-directed Spending 

section.  

Note 2: Even under Scenario (b) (Associate Revenues greater than 

Budgeted Revenues), this reporting option still requires manual 

calculation to determine the actual balance. 
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Option 1: ConnectCarolina Budget Overview shows the trust balance, adjusting for Associate Revenues generated in the 

period. Run the inquiry and enter the following parameters: 

Field Inputs Notes 

Ledger Group TRUST (description: Trust Expense Budget) You can save a search name with TRUST as the 

default Ledger Group. 

Chartfield Criteria: 

 Source 

 

Enter the specific Search in the “From 

Value” column. There is no need to input 

into the “To Value” when specifying a 

single value. 

 

Leave all other fields with the default “%”.  

Since each Source is naturally associated with a 

specific Fund range, there is no need to specify a 

Fund. 

 

The results will show either of two scenarios since ConnectCarolina calculates the balance based on the greater of 

Budgeted Revenues or Associate Revenue: 

Scenario (a) – Budgeted revenues are greater than Associate Revenue: The balance per ConnectCarolina is calculated 

based on Budgeted Revenue (as circled). Even if actual revenues are generated in this Source, no Associate Revenue is 

shown. Use caution when interpreting this balance, however, since it only shows budgeted revenues, which may not 

fully be generated in the year. (This is the same trust fund as what is displayed in Option 2 on the previous page.) 

 

Scenario (b) – Associate Revenues are greater than Budgeted Revenues: This is the reverse of Scenario (a). Even though 

you might have set up revenue budget in that source, the budget will not be shown and Associate Revenue is what 

guides the BBA calculation. 

 

 

 



 

Information in this document is current as of 2/2/2015. Infoporte is being updated on a continual basis and information may be outdated p.16 
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V. Transaction Inquiry 

The Transactions tab (Dept Accounting > Transactions) is where you can go to: 

• Review and download transactions for analysis (the Excel download is quite good) 

• Reconcile transactions 

• Cost code transactions 

• Add comments on transactions  

A. Refresher: Ledger Groups and Budget Ledgers 

It is critical to understand the Ledger Groups and budget ledgers you would like to inquire on (refer back to Section II.) 

There are 4 Ledger Groups (State, F&A, Trust, and OSR) split between Revenues and Expenses.  

Expense-related transactions are recorded on 4 budget ledgers. Revenue-related transactions are recorded on 3 budget 

ledgers. These are all listed the table below. The Ledger Groups with corresponding budget ledger codes from the 

inquiry’s drop down menu are also pictured below. 

Expense Budget Ledger Transactions Tab Code (_EX) Revenue Budget Ledger Transactions Tab Code (_RV) 

Budget 

Encumbrance 

Expense 

Pre-encumbrance 

_BUD or _BD 

_ENC or _EN 

_EXP or _EX 

_PRE or _PR 

Budget 

Recognized 

Collected 

_BD 

_RE 

Not used in the Transactions tab 

 

To run an effective transaction inquiry, you must choose the 

source of data from the appropriate Ledger Group and 

appropriate budget ledgers. For example, here are some possible 

combinations: 

• Choosing only state expenses (e.g. STAT_EX_EX) 

• Choosing only encumbrances in F&A (e.g. F&A_ENC) 

• Choosing only state recognized revenues  

 (e.g. STAT_RV_RE) 

• Choosing all OSR transactions, including budgets and  

 encumbrances (e.g. OSR – click at the top level) 

• Choosing only state budget transactions (STAT_EX_BD) 

• Leave as “Show all” to show all transactions. 

The options available from this dropdown are equivalent to the 

Finanseer “include transactions” filter where you can choose to 

exclude or include budgets, encumbrances, etc.  
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B. Running a Transaction Inquiry  

1. Enter your parameters. 

Field Inputs Notes 

Ledger Choose the appropriate ledger group(s) and 

budget ledger(s). 

 

Fiscal Year This should default to 2015.  

Budget Period This should conform to the Fiscal Year for 

State, F&A, and Trust.  

This field does not apply to OSR (but even if you fill it in, 

it won’t impede your results). 

Acct Prd Check off the appropriate months for which 

you would like to download transactions.  

You can filter by one month or leave it as “show all” for 

year-to-date results. 

Dept ID Only the departments with your access will 

result; you might refine if you have access 

to more than one department ID. 

 

Project Enter to inquire on OSR or cost share.  A few combinations may be used: 

• Project ID with OSR Ledger expenses would 

only show grant transactions 

• Project ID with State Ledger expenses might 

show any cost share activity 

• Project ID with Ledger as “show all” would 

show both OSR and all cost share (whether 

from state, trust, or F&A) 

Program Optional  

Account Optional Currently, there is only capacity for entering one 

account, which is not particularly useful except in very 

targeted searches. [An enhancement ticket has been 

submitted to request the old Object code tree 

breakdown such as personnel/non-personnel, etc.] 

Bus Unit Leave   

Source Optional  

Fund Optional  

 

There is a dropdown menu by clicking the arrow to the left of the “Advanced” heading. Here, you can search more 

specifically on transactional descriptors. For example, you might want to search through a specific expense ledger for 

payments to a certain vendor. Or you might have a Journal ID and want to understand what that transaction was for. 
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2. Add Buttons for Additional Columns 

You will notice that throughout the search filters are terms that look like buttons. If you click on them, they will turn blue 

to activate like this:   The next time you click Search, these activated fields will turn into additional columns 

in your search results. 

3. Click the Search button to run the search based on your parameters. 

After you run your search, you can click the “More” button to expand the screen to show more columns. 

 

4. Download your results. 

To download the results to PDF or Excel, click the appropriate buttons.  The Transactions inquiry results are 

formatted very well for Excel analysis.  

C. Features of Results 

Most of the columns allow for clicking the heading to sort them (including Amount now!) Take note of the following 

columns when interpreting the results: 

Column Notes 

Ledger If you did a broader search, budget and expense transactions might be commingled in this listing so be 

sure to take note that you’re looking at the type of transaction that you want. 

Acct Desc This Account Description field is a useful aggregator of accounts. This is also the same mapping of 

accounts to descriptions for the Ledger Rollup presentation. 

Employee This field has been removed in the latest update. 

Trans Type This field specifies the broad category of transaction types available in the system:  

 

Trans Type Description in English 

AP_VOUCHER, AP_ACCTDSE, P_VCHR_NP, AP_ACCT_LN Voucher 

AR_MISCPAY Deposit 

AR_REVEST Rev Estimate on Grants 

BI_INVOICE Billing entries 

GL_BD_JRNL Budget journal or transfer 

GL_JOURNAL GL Journal 

GM_FA Grants F&A 

HP_PAY_ENC HR Payroll Encumbrance 

HR_PAYROLL Payroll Transaction 

PC_BUDGET OSR Project Setup 

PO_POEND Purchase Order 

REQ_REENC Purchase Requisition 
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Column Notes 

Description, 

Trans ID, 

Reference 1, 

Reference 2 

The Trans Type determines the details of the Description, Trans ID, Reference 1, and Reference 2 as 

follows (for major types): 

 

Trans Type Description Trans ID Reference 1 Reference 2 

Any of the 

VOUCHER 

types 

Vendor ID | Vendor 

Name  

Voucher ID | Invoice # 

 

Note: employee travel 

reimbursements will 

have the T-number as 

the Invoice # 

Payment 

Reference ID | 

Payment Date 

PO # (if 

applicable) 

AR_MISCPAY n/a Deposit Unit | Deposit 

ID 

n/a n/a 

GL_JOURNAL For JEs converted 

from FRS or 

Correcting JEs of 

converted data:  

Finanseer Reference | 

Finanseer Date | 

Finanseer Transaction 

Description 

 

 

 

Conversion Batch# | 

Conv Date (e.g. the 

month end) 

 

 

Finanseer 

Trans Type | 

Finanseer 2nd 

Reference 

 

 

n/a 

For JEs from 

ConnectCarolina: 

Journal Line 

Description – input 

when preparing JEs 

 

 

There are many other 

alternatives that you’ll 

recognized, such as 

“FEDEX” or “Air Gas”  

 

 

Journal ID | Journal 

Date 

 

 

Reference; PID 

for certain 

journal types 

(GSHIP) 

 

 

n/a 

HR_PAYROLL Employee Name Payroll Batch Date | 

Sequence # 

PID n/a 

GL_BD_JRNL Journal ID | Journal 

Date 

n/a n/a n/a 

REQ_PREENC n/a Requisition ID n/a n/a 

PO_POENC Vendor ID | Vendor 

Name 

PO ID n/a Requisition ID 

Recon Ready? If “Y”, then this transaction has completed approval workflow and is posted. Only these transactions 

marked with a “Y” should be reconciled. If this field is blank, then the transaction has not yet 

completed workflow and/or may be transferred to the following month. 

Reconciled If checked off, it means that someone has gone in to verify the supporting documentation. Hovering 

over the checkmark will display the onyen of the person who completed the reconciliation. Downloads 

to Excel will indicate “Yes” in this column. 

Acct Dt The Accounting Date represents the date of the underlying transaction. 

Trans Dt This field has been removed in the latest update. 

Pymt Date This field has been removed in the latest update. 
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D. Reconciling Transactions 

In this section, “Reconciling” refers to the process of verifying that posted transactions are backed up by supporting 

documents and documenting the verification. Each department might reconcile transactions differently. Infoporte has a 

mechanism for checking off reconciled transactions within the Transactions tab. 

1. Run the appropriate transaction set. When reconciling grants, be careful to exclude cost share. 

2. Check off the transactions for which you have verified backup. Each department will maintain and file 

supporting documentation separately. 

 
3. On the right side of the screen, click the “Reconcile” button. 

4. Then, the transaction will be checked off in the Reconciled column to indicate the transaction was verified. 

Hovering over the checkmark with your mouse pointer will tell you who reconciled the transaction and when.  

 

5. It is possible to unreconcile a transaction by checking off the transaction and clicking the “Unreconcile” button. 

Considerations 

• It is critical to inquire the proper transaction set.  

• If you prefer to reconcile by pen and paper rather than through Infoporte, you may consider the following: 

o Download the Transactions listing to PDF – currently, this listing is not very good (the vendor IDs are 

included but not the vendor name), but may be improved in the future.  

o Download the equivalent Ledger Rollup for the month to show total monthly transactions and then 

download the Transactions inquiry to Excel for printing. The sum of the Transactions should total the 

Ledger Rollup. 

• You may or may not choose to reconcile pre-encumbrance or encumbrance transactions. Encumbrances that 

haven’t moved to Expense in a long time may indicate an issue, however. 
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E. Adding Comments to Transactions 

• After running an inquiry, you can show additional columns by clicking the “More” button at the top right of the 

results. 

 

• If cost codes were added, the cost codes will show in the 

“IPT Code Code” column. 

 

• A Comments column also appears. This column allows you 

to add comments to the transactions for additional 

internal reference as necessary. Note that all staff that 

have access to the department will be able to view your comments. 
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VI. Cost Coding 

Similar to old Infoporte, it is possible to tag cost codes on transactions in order to develop useful reports to monitor 

various aspects of operations. As of the time of writing, the set of cost codes available in ConnectCarolina were not 

compatible with Infoporte.  

A. Creating Infoporte Cost Codes 

As you’re aware, you can cost code directly in ConenctCarolina as part of the transaction’s optional chartfields using Cost 

Code 1, 2, or 3. Alternatively, you can create cost codes in Infoporte using the process as follows: 

In the Dept Accounting tab, go into Cost Codes. Click on the “new Cost Code” button. 

 

On the next screen, enter a name for your new cost code. You are only allowed to enter 9 characters max; the first letter 

will default to “H” representing SPH. You can enter a budget, relevant dates, and a budget amount. You can also enter 

additional descriptions comments. When you’re done, click “Create Code Code”. Note: at this point, there does not 

appear to be a mechanism to delete cost codes, so if you erroneously create a code code, you can edit or inactivate it, but 

not necessarily delete it. 
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B. Adding an Infoporte Cost Code to a Transaction 

To cost code a transaction, go to the Dept Accounting – Transactions page: 

1. Run the appropriate transaction set. 

2. Check off the transactions that you would like to cost code. 

 
3. On the right side of the screen, click the “Tag Selected” button. 

4. A window will open allowing you to specifying 

the appropriate cost code. The system will 

generate possible results as you type. 

5. Click “Apply Tag” to cost code the transaction.  

6. It is possible to apply more than one tag to a 

transaction by using the “Multi-Tag” tab in this 

window and similarly applying cost codes.  

7. To remove a cost code, applying the same steps 

but click “Remove Tag”.  

 

 

C. Running Reports on Cost Codes 

Cost Code reporting is done in the Financial Reporting (SAS menus). Upon going into the Financial Reporting tab, select 

the Cost Codes menu. 

 

Since ConnectCarolina and Infoporte cost codes are not yet compatible, the reports are separate.  

1. To report on ConnectCarolina cost codes, choose the Cost Code Financial Breakdown report.  

- In this report, the fiscal year defaults to 2015, so it will show year-to-date information. 

- Restrict the report to specific Accounting Periods if you like. Otherwise, it will show all. 

- Type in your cost code in the appropriate cost code field (i.e. Cost Code 1, 2, or 3 – generally it will be Cost Code 

1). The system will likely automatically complete the field based on the letters you enter. 

- The results will update as you enter the parameters, showing the total “Actuals” spent as charged to this cost 

code. If a budget was uploaded in ConnectCarolina, that would appear as well, showing the balance. 
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- To drill down into your results, either double-click into the actuals amount, or click into the “Ledger Group 

Account Rollup” or “Ledger Group Account Detail” sections of the report. 

 

- The Ledger Group Account Rollup aggregates by expense types (personnel, non-personnel drilling down into 

supplies, etc.). The Ledger Group Account Detail shows each transaction as an individual line. Note: Requisitions 

and encumbrance transactions are commingled into the report under the heading “KK Trans Type” (PO_POENC 

and REQ_PREENC). It is best to export the detailed transaction listing to excel to filter out those transactions for 

analysis.  

 
- To export the transactions set, right-click anywhere in the listing and choose “Export List Table 1”.  

 

2. To report on Infoporte cost codes, choose the Infoporte Cost Code Report. 

- Enter a cost code. Note the placement of the “dash” in the naming convention.  

- The summary of the charges posted to the cost code will appear. 
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VI. Other Infoporte Tips 

Bookmarks 

• Bookmarks are extremely useful if you frequently run the same inquiry. Bookmarks save your search parameters 

in specific tab. For example, if you frequently run an OSR Ledger Rollup on a specific Project ID, you can save this 

search. 

• Click on the Bookmarks icon at the top of the page, edit the name to something useful, and then click “Add”. 

• Bookmarks may be accessed from any page. 

• Currently, it is not possible to edit bookmarks; you need to delete them (click the “pencil” button and then the 

“x” to delete) and then re-add a new bookmark. 

• Bookmarks are not available for the Financial Reporting SAS reports. 

 

 

Control-click to open a new tab 

• It is possible to open multiple simultaneous instances of Infoporte. As you are working on one tab, click 

“Control+click” on another menu bar (or another tab name) to open a new tab for that tab name. This way, you 

can toggle back and forth between two instances. For example, you might have a Ledger Rollup on one tab and 

Transactions on another tab.  

Sorting on columns 

• Especially useful in the Transactions tab when you are filtering through long lists of data. Clicking on the column 

header will sort the results, either in ascending or descending order, based on that column’s values. 

• It is possible to apply two sorting filters by “Shift+click” on a second column header.  

• For example, it is possible to sort both by Employee first and then Acct Dt second. 
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Chartfield Lookup 

• The Tools > Data Dictionary > Chartfield Lookup tab is extremely handy.  

• This page includes lookups for all of the key chartfields. For example, if you came across a department ID and did 

not know who that represented, you can look it up here. 

• For reviewers wanting to ensure an account was charged correctly, you can look up to see if the account was 

appropriate based on the looked up description. 

General Info 

• The Tools > Data Dictionary > General Info tab is a repository of a number of forms and reports. 

• Come here to download the latest system access form  if changes need to be made or if your department has 

new staff who need access. 
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Appendix 1. ConnectCarolina Budget Definitions 

Note: These budget definitions are customized for users in the School of Public Health only. 

Ledger Group: F&A  (Description: F&A Expense) 

Fund Source Department Account 

27100 14101 Specific Not budgeted 

 

Notes 

- Campus users will only enter F&A budget transfers. 

- Account is not budgeted – there is no need to move money to cover specific accounting line items. 

- Specific department must be indicated – will implicate departments with multiple department codes. 

 

Ledger Group: STATE  (Description: State Expense Child Budget) 

Fund Source Department Account* Fringe Benefits 

201XX  Acad. Affairs 

211XX  Health Affairs 

212XX  AHEC 

 

Selected Purposes: 

01 Reg Term Instr 

10 Org’d Research 

30 Student Financial 

Aid 

52 General Acad 

Supp 

93 AHEC Health Sci 

Supp 

Specific 

Source 

 

 

Specific 511000  Other EPA Salaries 

511100  EPA Non Teach  

512000  Other SPA Budget 

512100  SPA Regular Salaries  

512300  SPA Premium  

513000  Other EPA Teach  

513100  EPA Teach  

514100  Non Student Temp  

514500  Student Temp Wages 

514000  Other Temp Wages 

 

520000  Purchased Services Budget 

521110  Transit Fees 

521210  Core Data Services 

529000  Utilities  

568000  Educ Award-Scholarship 

569000  Other Educational Award 

580000  Transfers Out 

515000 Fringe Benefits 

515100 Social Security 

515200 State Retirement 

515400 Optional 

Retirement 

515500 Medical Insurance 

517000 Other Personnel 

Payments 

519000 Worker Comp 

Claims 

 

 

 

* This listing excludes LEO- and library-related expense accounts not applicable to SPH. 

 

Notes 

- It is prohibited to move State funds budget between Academic Affairs, Health Affairs, and AHEC. 

- Fund is budgeted at the detail level; it is necessary to specify the appropriate purpose in the Fund. 

- State appropriated funds for distance learning must stay within distance learning fund codes and fund sources. 

- When transferring budget from non-compensation to compensation to cover grad students enrolled in GSHIP, 

must also include health insurance component. 
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Ledger Group: STATE_REV  (Description: State Revenue Budget) 

Fund Source Department Account 

201XX Acad. Affairs 

211XX Health Affairs 

212XX AHEC 

 

Selected Purposes: 

01 Reg Term Instr 

10 Org’d Research 

30 Student Financial Aid 

52 General Acad Supp 

93 AHEC Health Sci Supp 

Specific Source 

e.g.  

13503 HPM Resid 

13515 PHLP Cont Ed 

13517 OSHERC 

13530 Exec Masters 

13531 Cert in Dis Mgmt 

13533 HB Cont Ed 

13568 PHNU Field Trng 

13579 HB EARP 

 

Specific Specific Revenue Account that 

applies, for example: 

 

458710  Fees-Short Course 

Registration 

458810  Fees-Application 

458850  Fees-Special Student 

 

Notes 

- State budgets must be balanced. For state receipts where revenues are variable, both a State Revenue Budget 

and a State Expense Budget need to be established. 

- Fund is budgeted at the detail level; it is necessary to specify the appropriate purpose in the Fund. 

 

Ledger Group: TRUST_REV  (Description: Trust Revenue Budget) 

Fund Source Department Account 

24100  Educ & Self-Supp 

28100  Endow Inc-Unres 

28200  Endow Inc-Restr 

29100  Univ Trust-Unres 

29200  Univ Trust-Restr 

29500  Auxiliary 

Specific Source Specific Not budgeted 

 

  

Notes 

- Trust funds encompass educational and self-supporting (non-state receipts, conference and worships, residuals), 

university endowment income, university trust, and auxiliary. 

- The budget for trust funds is determined as the greater of associated revenues or budgeted revenue.  

- Most trust funds will not require any budget journals. As funds are collected, spending authority increases. 

- For trust funds where spending may happen before revenues are generated (i.e. recharge centers or conference 

accounts), only a trust revenue budget is required – there is no need to budget on the expense side. 

 

Ledger Group: COST_CODE, COST_CODE2, COST_CODE3  (Description: Cost Code Expense Budgets) 

Cost Code 1 or Cost Code 2 or  Cost Code 3 

  Specific cost code    Specific cost code    Specific cost code 

 

Notes 

- Each cost code chartfield is a separate Ledger Group.  

- SPH cost codes have been generally set up in the Cost Code 1 chartfield, which corresponds to the COST_CODE 

Ledger Group. 
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Appendix 2. Excel PivotTable Tips 

Overview and Requirements 

• PivotTables enable you to aggregate, analyze, and drilldown detailed data quickly and easily. 

• Requirements: a “flat file” table* that looks like this: 

Date Object Code Obj Desc Amount 

10/1 1210 SPA $500 

10/1 1310 EPA $750 

11/1 1110 EPA NT $250 

12/1 1210 SPA $800 

 

• NOTE: aggregated or “crosstab” data won’t work – cannot have headers along rows like this: 

 

 

 

 

Initial Setup of Row and Column Labels 

• Highlight a data table (headers and body) you’d like to summarize. 

• Go to the Insert menu → Choose “PivotTable”. 

• A new sheet will be added showing the following PivotTable wizard:

 

• Experiment with different fields in the column label or row label. 

• Multiple levels of labels may be used either in the column or row label.  

 

 

Top row = HEADERS. All must be present. If one 

column header is blank, the result will be messed 

up. (Excel versions <2010 will not even create it.) 

DATA in the body. This could be any type of data and 

most useful if at least one column can be added up 

(e.g. financial data), but it is not necessary depending 

on your needs. 

Your table headers will 

appear in this list as 

“fields” for you to choose. 

Drag any of these down to 

either the “Column 

labels” or “Row Labels” to 

create the indices of your 

PivotTable. 

Drag fields that may be 

aggregated into the 

“Values” box. 

Any field may also be used 

in the “Report Filter” box 

(next section). 

 Column header 1 Column header 2 Column header 3 

Row header    

Row header    

* “table” used in this write-up means an abstract structure of data where there is a header row and data in the body. It does not 

refer to the formal Excel Table object. 
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Filters and Slicers 

• Filters allow you to only show meaningful information, such as removing budget and encumbrance 

transactions from true financial transactions (e.g. Filter on “Code” to exclude the 50’s range). 

• Slicers allow you to visualize the specific filters: (Excel 2010 only). Click anywhere on your PivotTable.  

Select Insert → Slicer. Choose the field for which you’d like to filter and click OK (you can choose more than 

one). Turn filter items on or off by clicking them. Multiple items may be selected using Ctrl (select each item 

individual) or Shift (click on two ends of a range) while clicking.  

 

Design and Display Options 

• Design options: Click anywhere on the PivotTable to see the “PivotTable Tools” menu. 

 
o Choose any of the preset color-schemes. Choose to “band” rows or columns. 

• PivotTable placement: The default is a newly-created sheet but you can move it to an existing sheet.  You 

can put two separate PivotTables adjacent to each other. In the PivotTable Tools “Options” ribbon, choose 

“Move PivotTable” in the “Actions” area and select a range. Be careful if there is a lot of existing data 

because the PivotTable will overwrite whatever is there.  

• Field settings: Set number format and subtotal preferences: Choose a field from the “Row Labels” box and 

click “Field Settings…”.  (You can also right-click from a field directly from the PivotTable and choose Field 

Settings.) 

• Tip: Use the Classic PivotTable View to enable better presentation of multiple levels of row labels. Right-

click on the PivotTable, choose “PivotTable Options…”, choose the “Display” table, and check “Classic 

PivotTable layout” 

• Control which lines subtotal: You can turn off subtotals for more succinct reporting especially if some fields 

are just descriptors (e.g. object code name).  

• PivotCharts: Just like how PivotTables are dynamic summaries of data, PivotCharts are dynamic charts based 

off of your PivotTable. These are only useful if your data facilitates charting. To add, click on your PivotTable, 

and select “PivotChart” from the PivotTable Tools Options ribbon under Tools. Choose the type of chart that 

you’d like to present. 

 

Other Tips and Further Training 

• Lynda.com course: Excel 2010 Pivot Tables in Depth 

• Create an Index for VLOOKUP: The PivotTable effectively creates a unique index as each column label and 

row label. This is useful if you want to understand a range of values in a data set for the purpose of doing a 

VLOOKUP. 

• Ensure a clean flat file: Finan$eer automatically adds a “total” row in the data, try to exclude this to ensure 

integrity of the PivotTable. 

 

 


